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1. Introduction 

1.1 Getting Started 
Welcome to SewClean - the embroidery file duplicate cleaner. You may use SewClean to find and 

select duplicate embroidery files on your hard drive (or removable, writeable media) and to safely 

remove them. Duplicates may be deleted to the Recycle Bin (where they may be recovered if 

desired) or moved to a user-defined folder for future deletion. 

 

The SewClean workspace is divided into two panes. The left pane contains the folder "tree" 

showing all the folders on your computer, including any attached removable media drives and 

networked drives. The tree can be expanded or collapsed by clicking on the "+" marks beside the 

adjacent drive name. The right pane is a work pane which displays different aspects of the search, 

as will be described below. 

 

The following discussion mirrors the various steps that appear as reminders at the bottom of the 

various panes: 

 

STEP 1: 

 

To begin using SewClean, expand the folder tree in the left pane which displays the top-level 

folders on your computer (including connected external drives and networked drives). Click on the 

"+" sign to open subdirectories. This is similar to folder navigation in Windows Explorer®, except 

that only folders (and no files) are displayed. In this way, you can navigate to a folder - or group of 

folders - containing the embroidery files that you want to check for duplicates. In Fig. 1, the 

Documents folder has been expanded to reveal several sub-folders which are known to contain 

embroidery files. 
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Figure 1 

 

Once the folders have been expanded, you can click (with your left mouse button) the adjacent 

check-box(es) to begin searching them for embroidery files. Generally, the higher up (closer to the 

"root" folder) in the tree hierarchy that you click a check-box, the more subfolders will be searched 

for duplicates, and therefore the longer it will take to perform the search. Therefore, to speed up the 

search process, you can restrict the search to a smaller subset of all folders on your system. 

 

 

STEP 2: 

 

Once you have chosen the subset of folders to be scanned (by clicking the appropriate 

checkboxes), the empty screen on the right of the SewClean workspace will populate with check 

boxes that allow you to select options for controlling how the duplicate search will be performed. 

(See Fig. 2 where the folder Emb_CD has been checked.) 

 

 

Figure 2 
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Figure 2 

 

Note that the title bar of the right pane indicates the number of files found in the checked folder(s). 

In this case, there are 782 files in the folder and its subfolders that will be checked for duplicates 

when SewClean executes.  

 

Next, there are various options which can be chosen that effect the way duplicates are found: 

 

•     ZIP + RAR Files. If this item is checked, then when SewClean scans the various computer folders 

for duplicates, it will look inside all compressed archive files too. This can significantly slow down 

the duplicate search process. If you use compressed files only for backing-up your embroidery files, 

it is recommended NOT to check this option. Note that any Zip or Rar files in the selected folders 

will be scanned for duplicates, even when this option is unchecked. 

 

•     Only Selected Folders. Check this option to restrict the duplicate search to the folders you 

selected (checked) in the left pane. Otherwise, all folders on your computer will be searched 

(subject to restrictions set by the following items). 
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•     All Fixed (Hard) Drives. Check this option to scan all the fixed drives in your system. This 

excludes external or network drives. 

 

•     All Removable Drives. Check this option to scan removable drives (USB) that are currently 

attached to your computer. 

 

•     All Network Drives. Check this option to scan all network drives. 

 

There is a button at the bottom of the right pane that can be checked to "minimize" SewClean while 

it searches for duplicates on your system. (SewClean will minimize when the duplicate search 

button is clicked.)  This is a useful option if your search path contains a lot of folders and files. 

Since the search may take several minutes, while SewClean is performing the duplicate search, 

you can run other applications. When SewClean is finished, it will automatically maximize itself. 

 

 

STEP 3: 

Begin STEP 3 by clicking the "Start Duplicate Search" ("spyglass" button .) 

 

While SewClean is searching for duplicates a status report will be printed out in the right pane (see 

Fig. 3). This indicates what activities are currently being performed. Depending on how many 

folders are being scanned, this step may take anywhere from several seconds to minutes or hours. 

The elapsed time for the search appears in the upper right corner of the pane title bar, and the 

number of files remaining to be read is indicated in the workspace.  
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Figure 3 

 

When the scan is completed, the files with duplicates are displayed in the right pane. (See Fig. 4.) 

The file path information (where the duplicates are located on your system) is indicated, along with 

icons showing the embroidery pattern contained in the files. The "primary" file is shown left-justified 

in the pane, with the proposed duplicates indented beneath it. Duplicates in the same folder display 

no additional folder information, whereas files in folders that are "children" of the primary folder 

have their path indicated relative to the primary folder. Duplicates that are neither in the same or 

child folders have their full paths displayed. 
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Figure 4  

 

Depending on how the Deletion Criterion were selected (you can change them by clicking the 

toolbar button ), certain duplicates will appear with a red "X" through them to indicate they 

are ready to be deleted. At this point, you should review the duplicates that were selected by 

SewClean, based on your deletion criteria and determine is any are incorrect ("false" duplicates). 

This can occur in "rare" cases when the stitch count, color count and pattern size criterion used for 

matching are met for two files, but the pattern is still different. In such case, visual inspection of the 

duplicate icons chosen for deletion is the only way to remove such files from the deletion list. This 

can be done by holding down the Ctrl key and clicking on the icon of the "false" duplicate(s). 

 

Performing this action will remove the red "X" from the file you click and remove it from the deletion 

list. If a particular icon is not "X"-ed out, and you want to add it to the deletion list, just Ctrl click on 

the file icon. Finally, you can clear all  the selected files at once by clicking on a blank part of the 

right pane. 

 

Complete STEP 3 by clicking on the "Delete Duplicates" toolbar button . This will delete the 

selected ("X"-out) duplicates and send them to the folders that were selected in the "Duplicate 
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Folders" dialog. You can change the destination folders for deleted duplicates at any time by 

clicking the toolbar button . 

1.2 Contact Us 
If you have any questions about the SewClean program, or any suggestions for improvements or additional 

features you would like to see added, please contact us at 

 

support@sandscomputing.com 

1.3 Purchase SewClean 
You may purchase SewClean from the Shop webpage of the S & S website: 

 

http://sandscomputing.com/products-shop/ 

 

Click the  SewClean product listing and then use the Add-to-Cart button to purchase the license. If 

you want to order a CD, use the down-arrow on the Add-to-Cart button to select the CD version of 

the software. 

 

To update to the latest version of the software, use the INSTALL link (to the right of the Add-to-Cart 

button) for either the 32 and 64-bit version of the product (depending on your Operating System). 

 

There is a 5 day DEMO period during which you may use the software (with only a restriction on 

the number of file that can be cleaned during that time). After that, you can either uninstall the 

software or purchase a license (Add-to-Cart). After purchasing the license, the registration 

information will be emailed to you and you can register the DEMO to make it a licensed copy. You 

DO NOT have to uninstall the DEMO if you want to keep the software, but only register it after 

receiving the license information. 

2. Menus 

2.1 File menu 
 

The File menu offers the following commands: 

   

Find Duplicates  Begin search through selected folders for duplicates. 

mailto:support@sandscomputing.com
http://sandscomputing.com/products-shop/
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Delete Duplicates  Delete selected duplicate files (move to Recycle Bin or user folder). 

    

Exit Quit the application 

 

2.2 Options menu 
 

The Options menu offers the following commands: 

   

Deletion Criteria  Select criteria for deleting duplicates. 

Duplicate Folders  Select destination for duplicates (Recycle Bin or user folder). 

    

Language Support  Choose language for SewClean interface and commands. 

 

2.3 Help menu 
 

The Help menu offers the following commands: 

   

Help Topics  List help topics 

    

Auto-Update  Allow updater to search (once daily) for updates 

Update Now  Checks website for newer version of software 

    

About SewClean Display program information, user registration, and version number. 

Change (History) Log  View text file containing history of program changes. 
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3. File Commands 

3.1 Find Duplicates 
 

Use this command to begin searching for duplicates of the files in the selected folders in the left 

pane.  

 

Before clicking this toolbar button, you must select certain criteria to guide the path that will be 

searched for duplicates. (See "Getting Started", STEP 2, for more information.) 

 

Duplicates will be marked for deletion and appear with a red "X" through them, based on the 

deletion criteria chosen in the File Deletion Criteria dialog. 

 

Shortcuts 

Toolbar:                    

3.2 Delete Duplicates 
 

Use this command to delete the selected duplicates. The duplicates will be placed in the folders 

chosen in the Duplicate Folders dialog. 

 

Shortcuts 

Toolbar:                    

4. Options Commands 

4.1 Deletion Criteria 
Use this command to open the dialog (below), which is used to select file extensions that will 

determine which duplicate types to delete and which to retain. You may choose up to three different 

file extensions (below we choose only two, "pes" and "jef") for the embroidery file types that should 

be retained (not deleted) during the duplicate scan. 
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The way these extensions are used to select files for deletion depends on the "retention logic" 

which is selected by choosing one or the other logic option below. If the "OR" logic option is 

chosen, then only a single file with the selected extension will be retained (that is, it is NOT marked 

for deletion). The order in which files are chosen for retention is determined by file extension order 

(1, 2, 3) chosen. If the "AND" logic option is chosen, then up to three file types will be retained for 

each distinct pattern. This is useful for users with multiple sewing machines that need to keep 

different file types for the same pattern. 

 

 

 

 

 

Shortcuts 

Toolbar:                    

4.2 Duplicate Folders 
Use this command to open the Delete Duplicates dialog (see Figure below) to set destination 

folders for duplicate files that will be deleted. 
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There are two options for both ordinary (uncompressed) files and files store in ZIP or RAR 

archives. Destination options include the Recycle Bin or a user-defined folder. (A separate folder 

option is provided for compressed files.) Click the browse (magnifying glass icon) button to look for 

possible user folder locations, or enter the name of a new or existing folder in the edit box. Files 

sent to the Recycle Bin can be either restored by right-clicking on the Recycle Bin desktop icon and 

choosing "Open" (and then restore items from there), or permanently deleted by choosing the 

"Empty Recycle Bin" option.                           

 

Since there is no way to write a RAR file (outside of the proprietary WinRar software), SewClean 

will extract the files from the RAR file archive that are retained (not duplicates) and rewrite them to 

a "zip" file with an extension "_rar" added to the file name. 

 

 

NOTE OF IMPORTANCE 

 

Care should be taken when specifying the Recycle Bin, since only files on hard drives of the current 

computer (not networked drives) will be placed there. Other files will be deleted and are 

unrecoverable. For safety, it is advisable to send duplicates to the user-defined folders and delete 
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them from there when they are no longer needed. Also note that files marked as duplicates on CD 

drives will not be deleted or moved. 

 

Shortcuts 

Toolbar:                    

4.3 Language Support 
Click on this Options menu item and select the desired language for displaying the SewClean 

commands and user interface. 

5. Help Commands 

5.1 Help Topics 
Use this command to display the opening screen ("Get Started") of Help.  From the opening 

screen, you can jump to step-by-step instructions for using SewClean and various types of 

reference information.   

 

Once you open Help, you can click the Contents button whenever you want to return to the opening 

screen. 

5.2 Auto-Update 
Use this command to toggle (turn on/off) automatic updating of SewClean software. When this 

menu item is checked (unchecked), auto-updating is allowed (prevented). With auto-updating 

allowed, the S & S website will be checked whenever the application is opened (but not more than 

once daily) for available updates. If there is an update available, the user will be given the 

opportunity to install it. The installation will automatically close the SewClean workspace, remove 

the older version, install the update, and restart the application. 

5.3 Update Now 
Use this command to search the S & S website immediately for the availability of an update for 

SewClean. If an update is found, the user is given a choice to install it. 

5.4 About SewClean 
Use this command to display the copyright notice, registration and version number of your copy of 

SewClean. 

5.5 Change (History) Log 
Use this command to display the history of changes made to SewClean. 
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5.6 Context Help 
Use this command to obtain context-sensitive help for toolbar and menu items. When you (single 

left) click this toolbar button, the cursor changes to a "?" icon. Then click on the item for which you 

want help, and the help manual will open to an appropriate topic. 

 

Shortcuts 

            Toolbar:              

6. Toolbars 

6.1 Main Toolbar 
SewClean Toolbar 

 

 

 

The toolbar is displayed across the top of the application window, below the menu bar.  The toolbar 

provides quick mouse access to tools used in SewClean. 

 

 

Click                To 

 

            Search folders for duplicates of files in selected folders (checked in left pane). 

 

            Delete selected duplicates. 

 

            Select criteria to guide searching folders for duplicates. 
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             Select destination (user-defined folders, Recycle Bin) for deleted duplicates. 

 

            Get context-sensitive help for items on the toolbar. 
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